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Abstract 

 The posterior basal third ventricle is situated in the midline, between the cerebral 

hemispheres, adjacent to hypothalamic nuclei pertinent to metabolic homeostasis.  The 

neuroepithelium lining the ventricle in this region is composed of ependymal cells and 

tanycytes. Ependymal (E1) cells extend multiple motile cilia from their apical surface, 

while tanycytes extend two motile cilia (E2) or a single non-motile cilium (E3) from their 

apical surface. This unique arrangement of neuronal nuclei lined by a mixed 

neuroepithelium in contact with the ventricle is suggested to provide neurons in this 

region with privileged access to signaling factors and other molecules in the 

cerebrospinal fluid (CSF).  However, CSF flow in this region has not been studied.   

Here, we characterized motile cilia-generated flow along the walls of the posterior basal 

third ventricle and found an unexpected asymmetry between the left and right sides.  

Flow generated by E1 cells on the left hemisphere was directed anterior and ventral, 

away from the tanycyte domain, while flow on the right hemisphere was directed 

posterior and ventral, towards the tanycyte domain.  To explore cellular planar polarity—

that is, polarity orthogonal to the apical-basal axis of an epithelium—that may underlie 

this difference in flow between the two hemispheres, we quantified “translational” planar 

polarity in E1 cells of this region.  Interestingly, E1 translational polarity reflected the 

flow of CSF across the epithelium in the right hemisphere, but not in the left hemisphere.  

Altogether, this work provides a framework for understanding how CSF flow in this 

ventricular region regulates the exposure of CSF-circulating factors to the adjacent brain. 
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Chapter 1: Introduction 

 

Cerebral Third Ventricle  

  The brain ventricular system filled with cerebrospinal fluid (CSF) is formed from 

the proper closure of the neural tube.1 CSF flow within the ventricles is crucial for normal 

central nervous system (CNS) development, maintenance, and homeostasis.2 The 

dominant epithelium lining the third ventricle (3V) are multiciliated ependymal cells, 

while the posterior ventral aspect of the 3V is lined by mono- and bi- ciliated tanycyte 

cells.3 Moreover, beneath the epithelium of tanycytes in the posterior ventral 3V are 

hypothalamic nuclei pertinent to metabolic homeostasis and it has been suggested that 

tanycytes link the CSF to neuroendocrine events.4 

 

Posterior Basal Hypothalamus & Energy Balance  

 The hypothalamus has roles in regulating energy homeostasis, fluid balance, 

stress, growth, reproductive behavior, emotion, and circadian rhythms. 5,6 Nuclei that 

comprise the hypothalamus are bilateral structures and anatomically largely symmetric 

with the third ventricle situated in the midline between the two sides. 6 The 

paraventricular nucleus (PVN) is composed of magnocellular, parvocellular, and long-

projecting neurons that play pertinent roles in energy balance.5 The arcuate nucleus 

(ARC), lies posterior and ventral to the rest of the hypothalamic nuclei and are composed 

of agouti-related protein (AgRP) and pro-opiomelanocortin (POMC) neurons, two 

antagonistic neuronal populations that regulate food intake.7 The ventromedial nucleus 

(VMN) has been implicated in glucose homeostasis8,9 while the dorsomedial 

hypothalamus (DMH) has been shown to have roles in energy balance by affecting both 

food intake and energy expenditure. 10 Together, these nuclei work in circuits to maintain 

metabolic homeostasis and their interface with the periphery is, in part, thought to be 

mediated by cells that line the third ventricle. 

 

Ependymal Cells & Tanycytes 

 The neuroepithelium that lines the dorsal anterior aspect of third ventricle is 

composed of simple cuboidal ependymal cells (E1)3. Ependymal cells are motile, 
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multiciliated cells that generate the driving force for CSF flow within the ventricular 

system. Laminar unidirectional flow of CSF is directed by the beating of E1 cells the 

most abundant ependymal cell within the entire ventricular system. 11E1 cells can range 

between 8-15 micrometer in length around 40-60 cilia are found on the apical surface of a 

single ependymal cell.12 Each cilia have an axonemal arrangement of 9+2 referring to the 

nine microtubule pairs that orient on the periphery and constitutes the length of the 

cilium, while two refers to the central pair unique to motile ependymal cilia. 12 

 Tanycyte cells are bipolar cells with microvilli and a primary cilium that has a 

9+0 axonemal arrangement. 4 They are further subdivided depending on their location 

where the dorsal most tanycytes are referred to as α1 and α2 while the ventral most are 

referred to 1 and 2. 4 Monocilia or primary cilia lie on their apical surface contacting 

the CSF, this organization and their lack of motility is thought to lend to their role as 

mechanosensory cells. 3,4,13,14 Receptors expressed on the surface of the cilium, is 

believed to mediate entry of metabolites from the CSF to brain parenchyma activating or 

suppressing neuronal circuits involved in maintaining metabolic homeostasis. 4,14  

 

Cilia Past & Present 

 First described by Leeuwenhoek in 1667 as, “…’incredibly thin little fit, or little 

legs, which were moved very nimbly’…”.15Over two decades later, Paul Lagerharn’s 

illustrations depicting cells of the liver, hindgut, and ovary of adult Amphioxus 

lanceolatus would include cilia but never described. 15 In 1898, Karl Wilhelm 

Zimmermann would be the first to describe in mammals including humans the presence 

of cilia on epithelial cells and postulating a function for solitary cilia: “One could also 

imagine that this delicate flagellum, whose movement may have no significant impact 

upon the secretions that are found in the glandular lumen, may work as a kind of sensory 

organ, that is, changes in the configuration of the secretions flowing inside the glandular 

lumen might have a stimulating effect upon the flagellum[cilia], whereby the secretory 

function might be qualitatively or quantitively affected.” 15 

 With the advent of staining techniques, a great curiosity for the study of cilia had 

emerged. Carl Benda in 1901 described cilia found on ependymal cells which line the 

brain ventricles. The classification of cilia into, multi-, mono-, and bi- was first described 
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by Joseph in 1905. Despite Zimmerman’s postulation that cilia had a sensory role, most 

who made mention of cilia in their work, either regarded it as vestigial or merely a motile 

structure serving little to no function. 15 

 As transmission electron microscopy (TEM) arose in the 1950s, the ability to 

visualize cilia became much more resolved. 15 The first report using TEM of primary cilia 

in neural tissue came from Duncan in 1957 while a year later Sotelo and Trujillo-Cenoz 

noted the 9+0 microtubule organization of monocilia. TEM, however, did not sway the 

notion that primary cilia were vestigial when Sorokin concluded in 1968, that “the 

function of primary cilia remains unknown,”  15 a sentiment echoed by those who studied 

cilia up until the end of the 20th century.  

 Currently, the study of cilia has become far more refined and specific gene 

signatures have been investigated through transcriptomic analysis16, flow analysis 

through fluid dynamics17,18, and genetic manipulations targeting specific proteins relevant 

to cilia motility and function.19 With the evolution of microscopy techniques such as 

super resolution microscopy, ultrastructural cilia components now have their time to 

shine in the fluorescent light. 

 

Brain Ciliogenesis 

 Derived from radial glia, ependymal cells, and the cilia they harbor mature and 

form postnatally. 20 Mother centrioles serve as the precursor to basal body formation, and 

once docked to the cell surface formation of cilia proceeds.21 The basal body then 

nucleates outgrowth of axonemal microtubules generating the cilium. 21 As ependymal 

cells develop, monociliated ependymal progenitor cells differentiate into multiciliated 

ependymal cells. 22 Transcriptional regulation of motile ciliogenesis is mediated by 

regulatory factor x (RFX) and the forkhead box J1 (FoxJ1) family proteins. 23 Further 

differentiation from mono-motile cilia to multiple motile cilia is transcriptionally 

programmed by MCIDAS (Muticilin) associating E2F transcription factors to activate 

centriole amplification genes. 23 A closer probe of the structural components that 

constitute differentiated cilia can further elucidate their roles in driving motility and as 

mechanosensory structures. 
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Ependymal Cilia Ultrastructure  

Cilia are structural protrusions that extend from the apical surface of ependymal 

cells lining the brain ventricles.21 A structure shared by both motile and non-motile cilia 

is the basal body a modification of the mother centriole comprised of nine triplet 

microtubules, subdistal appendages, and nine distal appendages that attach to the base of 

a cell.21  The axoneme extends out from the cell’s apical surface and consists of nine 

doublet microtubules that originate from the basal body. Axonemal microtubules are 

composed of one complete microtubule (the A tubule) connected to an incomplete 

microtubule (the B tubule) making up its doublet structure. 21 A transition zone formed 

early in ciliogenesis is maintained by the proximal-most region of the axoneme 

controlling the entry and exit of various factors. 21 This transport is maintained by 

an intraflagellar machinery whereby Kinesin-2 drives anterograde movement from 

transition fibers to the cilia tip, while Dynein-2 drives retrograde movement. 21 Unique to 

motile cilia is a central pair composed of a doublet microtubule attached by radial spokes 

and dynein arms to the outer microtubules, the primary proteins driving the motility of 

cilia. 21  

 

Ependymal Cell Motility & Polarity 

  E1 cells in brain ventricles are terminally differentiated epithelial cells that form 

the interface between the extracellular milieu and surrounding tissues.24 Their 

coordinated beating generates forceful and directed laminar flow over the 

neuroepithelium.25  This motility is essential to maintain ion concentrations, remove 

metabolic byproducts, and deliver growth factors to various areas of the brain via the 

cerebrospinal fluid (CSF).26 Coordinated beating of cilia is carried out by the basal foot, 

an electron-dense conical structure that protrudes from the basal body’s cytoskeleton.27 

The orientation of the basal foot points in direction of CSF flow.28,29  This unidirectional 

orientation of cilia with respect to its long axis is referred to as rotational polarity, 27,29 

while the positioning of the cilia patch on the apical surface of the cell is its translational 

polarity. 27  Rotational and translational polarity are determined separately 26,30 and 

ablation of motile cilia disrupts rotational polarity but not translational polarity 29. 

Moreover, ablation of radial glia primary cilia does affect translational polarity. 29 Cilia 
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beating is asymmetrical beginning at the cell base when the cilium is propelled forward 

during the effective stroke, and then returns to its initial position during the recovery 

stroke. 31 This beating generates the laminar flow of CSF with the effective stroke 

generating most of the fluid displacement. 31 Given the structural complexity of motile 

and non-motile cilia, it should come as no surprise that dysfunction to any component 

part would lead to pathological manifestation. 

 

Brain Ciliopathies  

 First described in 1984 and popularized in the 21st century ciliopathies are 

dysfunction in either motile or immotile cilia.32  Ciliopathies can be divided into motile 

or sensory ciliopathy. 32  An example of motile ciliopathy is primary ciliary dyskinesia 

(PCD) marked by symptoms that include situs inversus, heterotaxy syndrome, chronic 

bronchitis, sinusitis, infertility, disposition to headaches, hydrocephalus, and otitis 

media.33 Joubert syndrome (JBTS) classified as a sensory ciliopathy affects the 

cerebellum.34 Symptoms of JBTS include retinal dystrophy, kidney diseases, liver 

diseases, skeletal deformities, and endocrine problems. 34 A more pertinent metabolic 

dysfunction associated with aberrant cilia is Bardet-Biedl Syndrome (BBS) with a 

hallmark symptom of hyperphagia and obesity. Several studies suggest that obesity in 

BBS results from hypothalamic dysfunction and satiety defects due to mislocalization of 

the Neuropeptide Y (NPY) receptor MCHR1 and Leptin receptor.35–37 
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Study Goals 

 A goal of this study is to showcase the whole mount technique to precisely 

preserve and study the left and right hemispheric walls that constitutes the third 

ventricle(3V). Understanding cerebrospinal flow in the 3V can offer insight to the 

circulation of factors to and from the hypothalamus lending to the homeostatic function 

that is integral to this area. We discovered a previously unrecognized asymmetry in flow 

generated by motile cilia of ependymal cells in this region. We also characterized the 

translational polarity exhibited by E1 cells to explore potential cellular determinants of 

the asymmetric flow observed within the posterior basal third ventricle. We speculate that 

this cilia-generated flow acts to compartmentalize the posterior basal 3V where mono- 

and bi- ciliated tanycytes reside.  
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Chapter 2: Methods 

 

2.1 Animals 

 For flow videos a total of 4 C57BL6/J mice age P60-P120 were used to represent 

cilia generated flow bilaterally.  To illuminate the area that makes up the posterior ventral 

third ventricle wall an Nkx2.1 mouse was used to generate image captures as represented 

in Figure 1B. For translational polarity analysis, 1 C57BL6/J mouse age P90 was stained 

and analyzed. 

 

2.2 Third Ventricle Ventriculotomy 

1. In a 6cm silicone dish, place ~5mL of L15 media warmed to 37oC to just about the 

rim of the dish. 

2. Cervically dislocate mouse. 

3. Separate the head from the body using surgical scissors. 

4. Take fine scissors and in a cutting motion insert one end of the open scissor through 

one eye socket and out toward the other, then close the scissors to make a cut across 

the frontal bone just slightly anterior to the olfactory bulbs.  

 

5. Still with the fine scissors, make two small lateral cuts along the skull on the 

posterior end to dislodge the brain from the skull. Be careful not to insert your 

scissors too far into the skull. This will cause inadvertent damage to the brain. 

6. From posterior to anterior, make a medial cut down the sagittal suture until you 

Created with Biorender.com 
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reach the cut end of the frontal bone. Again, take care in making your cuts as to not 

cut into the brain. 

7. Using the angled forceps gently tease open the skull flaps.  

8. As the brain is exposed, tease the brain away from the base of the skull by beginning 

at the rostral end using sweeping motions to first free the olfactory bulbs.  

9. Continue to dislodge the brain from the base of the skull until you reach the 

trigeminal nerves, the last point of connection between the skull base and the brain.  

10. Cut either side of the nerve to separate the brain from the skull. 

11. With the angled forceps allow the dissected brain to fall directly into the dish with 

media. 

 

12. Under a dissection microscope using 1.0x magnification, take the fine forceps and 

anchor the cerebellum down with the forceps while the dominant hand is used to 

hold a stab knife. Make a coronal cut posterior to the olfactory bulbs. Discard 

olfactory bulbs.  

13. In a similar manner, make a coronal cut anterior to the cerebellum. Discard 

cerebellum. 

14. Using angled forceps, orient the remaining cerebrum with the ventral surface up. 

15. Make precise cuts using the stab knife along the midline to separate the brain into 

two halves with the walls of the third ventricle now exposed. 

16. Using the fine forceps, anchor one half of the brain to the dish by placing the point 

of the forceps into the lateral cortical side.  

17. Make a cut on the lateral edge just medial to where the forceps are anchored. 

Created with Biorender.com 
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Discard the side where the forceps were anchored. 

18. Allow the brain to fall flat onto the dish with the exposed third ventricular wall side 

up.  

19. Orient the brain to run posterior/anterior and dorsal/ventral if working with the left 

hemisphere and anterior/posterior and dorsal/ventral if working with the right 

hemisphere.  

20. If using for immunohistochemistry, fix wholemounts in a 24 well dish with 2mL of 

4% PFA+ 0.1% Triton X solution. If using for 3V flow analysis, skip fixation step 

and move forward with flow protocol. 

21. Allow wholemount to fix overnight and subsequently wash with PBS with 0.1% 

Triton X. Wholemounts can be temporarily stored in PBS+0.1% Triton X + Sodium 

Azide, long-term storage of wholemounts is not recommended. 

 

2.3 Generating Flow Movies 

1. In a 1.5mL Eppendorf tube mix 100uL of glycerol, 400uL of fluorescent 

microspheres, and 500uL of distilled water. Triturate until thoroughly mixed. Wrap 

with foil to shield from light.  

2. Backload a microneedle with mineral oil about halfway up the length of the 

microneedle.  

3. Coat a trimmed plunger with grease a third of the way up the length of the plunger.  

4. Take the greased end of the plunger and insert into the top opening of the 

microneedle. 

5. Advance plunger until the oil is flushed to the tip of the needle.  

6. Place the needle onto the multidimensional adjustable arm that lies adjacent to the 

fluorescent stereomicroscope.  

7. Submerge the tip of the microneedle into the 1.5mL tube of fluorescent 

microspheres made from Step 1 just enough to be able to draw up the microspheres. 

8. With the micromanipulator load the needle with microspheres to the capacity of the 

micromanipulator. 

9. Take a 1.5mL tube filled with fresh L15 media and submerge the tip of the needle 

to clean residual microspheres that may have accumulated on the outside surface of 
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the needle. 

10. Adjust the arms such that the tip of the microneedle is now hovering just above the 

foramen of monro on one of the wholemounts.  

11. Prior to ejecting any microspheres from the needle, make the necessary adjustments 

to optimize the field of view on your recording screen as well as the 

stereomicroscope.  

Scope magnification?  

12. Slowly eject fluorescent microspheres from the microneedle and begin recording.  

 

2.4 Immunofluorescent Staining of 3V 

2.4.1 Staining 

1. Incubate PFA-fixed left and right hemisphere wholemount in a well of a 24-well 

plate with 100mL of PBS + 0.01% Triton-X per well. 

 

2. In a 15mL Falcon tube, make primary solution of Beta-Catenin (1:2000) and 

Gamma-Tubulin (1:1000) with a final volume of 1000mL per brain. 

3. Replace PBS solution with primary solution and place plate on nutator in 4 degrees. 

Incubate in primary for 3 overnights.  

4. On fourth day of incubation, aspirate primary solution and wash brains with PBS + 

0.01% Triton-X at least 5x.  

5. In a 15mL Falcon tube, make secondary solution of desired fluorophore for each of 

Beta-Catenin and Gamma-Tubulin.  

6. Incubate in secondary solution on nutator in 4 degrees for 2 overnights. 

Created with Biorender.com 
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7. On third day, aspirate secondary solution and wash brains with PBS + 0.01% 

Triton-X at least 5x.  

8. Using a dissection scope, mount each hemisphere en-face on a slide and coverslip. 

Let dry for several days. 

 

2.4.2 Mounting 

1. Take a stained wholemount and place in a 6cm dish filled with PBS.  

 

2. Using a dissection microscope at 4x magnification, isolate third ventricle wall by 

trimming excess tissue at the anterior and posterior ends of the ventricle. Tip: Good 

lighting when doing dissection with the scope allows you to better make out the 

borders of the ventricle. 

3. Make a dorsal cut at the dorsal-most aspect of the third ventricle.  

4. Stand the wholemount such that the ventral end touches the dish and make a precise 

cut to trim off excess tissue that lies lateral to the wall of the ventricle. Note: This 

step determines the thickness of your tissue and what you will mount to a slide.  

5. Using fine forceps, lift isolated ventricle slab and lay onto slide with the ventricle 

side up. Be careful not to pierce through any part of the tissue at this point. 

6. Allow most of the excess PBS to dry but not to the point that the tissue dries out.  

7. Add 3-4 drops of water based mounting media (not too much) to your wholemount 

slab. 

8. Gently coverslip over wholemount and allow weight of coverslip to disperse 

mounting media and further flatten wholemount. Repeat for every single 

wholemount. 



18 
 

2.5 Confocal Imaging of 3V  

1. Using a Leica, Stelaris 5, Wetzlar, Germany confocal microscope set imaging 

parameters as follows: 1024umx1024um, 63x objective ,1.5x zoom, and z-section 

= 0.5um. 

2. Select ROIs using the LAS navigation feature on the LAS X software.  

3. For each ROI, indicate z-stack to include only the surface most area of the brain. 

This is crucial in imaging the correct anatomical features of the cell membrane and 

for accurate quantification of basal body translational polarity. 

4. Each tile image captured should be representative of the posterior basal wall. 

 

2.6 Cilia Translational Polarity Quantification 

2.6.1 Generating Beta Catenin Segment and Gamma Tubulin Images  

1. Upload a tile image as instructed above from section 2.4 Confocal Microscopy into 

ImageJ and transform the image to capture the true anatomical features of the basal 

bodies and cell membrane. Note: Depending on the confocal microscope being 

used, images are not always produced in their true orientation, so transformation of 

the image must be carried out.  

2. Using ImageJ, select Split Channels so each beta-catenin and gamma-tubulin have 

their own working window. Work with one channel at a time.  

3. Select Z project from the Image menu to create a maximum projection of the 

channel.  

4. If there are areas that are not in focus, Photoshop can be used to choose the z-slice 

with the most accurate representation of the membrane/basal body prior to 

generating a max projection image. This step is necessary to capture an accurate 

representation of the cell membrane as an out of focus image will distort the cell 

shape generating inaccuracies in future analysis in cell center designation.  

5. Save the maximum projection of each channel as a .tif extension. From the Plugins 

menu, select Tissue Analyzer.  

6. Drag Beta-Catenin.tif file into the Tissue Analyzer window. Generate segmentation 

file by selecting Detect Bonds (save watershed) from menu bar. 
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7. This will generate a folder where the Beta-Catenin file was dragged from with the 

same name. In the folder a handCorrection.tif file will be found. 

 

2.6.2 Centroid Designation  

8. Open the gamma tubulin file in ImageJ. 

9. Select the Point Tool on the menu bar.  

10. Set Type to Cross, Color to Yellow, and Size to Medium. Magnify image to 200%.  

11. Place crosshairs at the center of each basal body. Note: It is a manual process so 

take care in selecting the center as it will be a point of reference for generating 

vector angles. 

12. After designating the center of each basal body, generate a flattened image. Select 

Image -> Overlay -> Flatten. Save flattened image. 

13. Open the handCorrection file in ImageJ.  

14. Set Point Tool settings to Type = Cross, Color = White, Size = Medium. Select 

Label Points. Magnify image to 200%.  

15. Designate the center of each cell with a crosshair and generate a flattened image 

and save. 

16. On the non-flattened image generate measures for each designated crosshair. Select 

Analyze -> Measure. Save the measures as a .csv file. 

17. Open flattened images in ImageJ and create an Overlay of the gamma tubulin + 

crosshair image and the handCorrection + crosshair image. Select Image -> Overlay 

-> Add Image. Select the handCorrection + crosshair file to and set Opacity to 50. 

18. Flatten generated overlayed image. Save. 

 

2.6.3 Drawing and Measuring Angle Vectors 

19. Open overlayed image and .csv file.  

20. Magnify overlayed image to 200%. Select the Angle tool.  

21. To draw the angle vector, start from the upper tip of the crosshair denoting the 

center of the cell, draw a line down to the center and click, then draw another line 

to the center of the crosshair denoting the center of the basal body.  

22. Draw the angle with Command + D.  
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23. Measure the angle with M. Input vector angles drawn as its own column of values 

on the .csv file generated previously.  

 

2.6.4 Polar Histograms in R  

24. Load .csv file into R.  

25. Load ggplot2 package library. 

26. Plot a polar histogram of the vectors measured using the following ggplot2 function 

(38.39):  

ggplot(R6C2,aes(x=Vector.Angle)) + 

geom_histogram(binwidth=15,colour="white", fill="black",size=.25) + 

guides(fill=guide_legend(reverse=TRUE)) + coord_polar() + 

scale_x_continuous( breaks=seq(0,360, by=45), minor_breaks = seq(0,360, by 

=15)) + scale_fill_brewer() + xlab(NULL) + ylab(NULL) 
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Chapter 3: Results 

 

Wholemount preparations of the rodent third ventricle provides a comprehensive view for 

studying cilia-generated flow.  

 We provide a clear demonstration on the utility of wholemounts in studying the 

cilia-generated flow within the posterior basal third ventricle. Figure 1 provides a clear 

outline of the precise and meticulous steps to preserve the posterior basal third ventricle. 

The right and left hemisphere are dissected separately with each wall of the 3V being 

isolated from the rest of the brain Fig 1A. With the entire wall of the 3V isolated, another 

dissection is made to separate the posterior portion of the 3V wall Fig. 1B. Introduction 

of a needle filled with fluorescent microbeads which is then deposited towards the 

neuroepithelium lining the wall of this posterior basal region, flow can be carefully 

studied with focus on the flow between the ependymal and tanycyte regions Fig 1C. 

Movies can be generated for both hemispheres that demonstrate flow on either side. 

(Movie 1 & Movie 2) 

 

Translational polarity can be quantified through histological analysis 

 Histological analysis of the translational polarity was carried out on 63x tile 

images using Beta-catenin to delineate individual ependymal membrane (Fig. 2A), and 

gamma-tubulin was used to label individual basal body (Fig. 2A and Fig. 2B).  A 

segmentation file was generated to outline the borders of each ependymal cell and 

superimposed with the gamma-tubulin channel to better delineate the cell membrane 

(Fig. 2B). Each segmentation and gamma tubulin file were analyzed separately with 

ImageJ. Centroids were designated for each ependymal cell and each basal body patch, 

and the two files were later merged. With the merged file a vector was then calculated as 

the angle from the center of the cell to the center of the basal body patch to indicate 

polarity of each cell relative to 0 degrees (Fig. C). The vectors generated for each tile was 

then plotted using R to produce polarity histograms that show the general trend of 

polarity within each tile image sampled (Fig. D). 
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Flow on the Left Hemisphere Is Directed Anterior and Ventral Away From The Tanycyte 

Region 

 Dispersion of fluorescent beads to the walls of the 3V on the left hemisphere was 

carried out to study the flow within the left hemisphere.  Interestingly, the flow of 

fluorescent beads was directed anterior and ventral away from the tanycyte region as 

represented in Figure 3 & Movie1. Another flow directed dorsally was observed but was 

not different between left and right hemispheres. 

 

Translational Polarity of the Left Hemisphere is Incongruent with the Flow Observed on 

the Left Hemisphere 

 To understand if translational polarity confered with the difference in flow 

observed within the left hemisphere histological analysis was carried out. A 4x4 grid was 

used to indicate the sampling area where flow was most prominent (Fig. 4). Each tile 

within the grid was then analyzed for translational polarity and polar histograms 

generated (Fig. 4). The polar histograms revealed that ependymal translational polarity 

was incongruent with our flow finding. Most of the ependymal cells generated a vector 

angle between 200o -300 o (Fig.4). 

 

Flow on the Right Is Directed Anterior and Ventrally Away From The Tanycyte Region 

 Dispersion of fluorescent beads to the walls of the 3V on the right hemisphere 

was directed posterior and ventral towards the tanycyte domain (Fig. 5). Flow directly 

over the ependymal region was fast while flow over the tanycyte domain was stagnant 

and slow as it traveled dorsally where flow picked up again in speed (Movie 2). 

 

Translational Polarity of the Right Hemisphere is Congruent with the Flow Observed on 

the Right Hemisphere 

 To determine if the same incongruence persists between flow and polarity on the 

right hemisphere, we carried out histological analysis of the right hemisphere.  

Interestingly, translational polarity as represented by polar histograms had vectors that 

ranged from 100o -180 o indicating that polarity pointed towards the tanycyte domain 

(Fig. 6). This agreed with the flow observed in the right hemisphere (Fig. 5). 
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Chapter 4: Conclusions & Future Directions 

 

Functional analysis of ependymal cell motile cilia-generated flow within the 

posterior basal 3V demonstrated an asymmetry between the left and right hemisphere.  

Flow directed anterior and ventral away from the tanycytic domain in the left hemisphere 

may serve as a means for limiting the flow of metabolic factors to this region. 

Conversely, flow directed posterior and ventral on the right hemisphere towards the 

tanycyte domain generates the flow necessary to deliver metabolic factors to this 

posterior area. Taken together, flow generated by cilia on both hemispheres in the intact 

ventricle may work in conjunction to compartmentalize this posterior basal area, 

generating a more stagnant or slow flow of factors allowing increased exposure time to 

mechanosensory cilia positioned to detect metabolically relevant changes as relayed by 

the CSF.  

 We showed congruence of cilia generated flow and translational polarity of 

ependymal cells in the right, but not the left hemisphere.  In other ventricular regions 

where this has been studied, including the left and right lateral ventricles, congruence 

between flow and translational polarity was consistently observed.  This makes the 

incongruence observed on the left hemisphere particularly interesting.  It will be 

important in future work to explore other cellular determinants of planar polarity, 

including rotational polarity. As previously mentioned, rotational polarity is the position 

of individual basal bodies relative to its basal foot, where the basal foot points in the 

direction of cilia beating and resulting flow.  Investigating rotational polarity exhibited by 

E1 cells on the left hemisphere may elucidate the asymmetric flow observed in our 

functional flow assays.  

 The wholemount technique and the ability to visualize the entire ventricular wall 

has provided us with insight into the flow within a seemingly unique area of the third 

ventricle both in its architecture and function. However, an obvious limitation to the 

studies carried out was that it was done in an open system.  To further confirm our 

findings, modeling flow within a closed system through fluid dynamic models can further 

provide insight into the functional significance of flow being antagonistic in this posterior 

basal area and its relationship with flow throughout the entire third ventricle. 
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Figures 

 
Figure 1. 3V Wholemount En-face A. Wholemount view of right hemisphere with rectangle selection(B) 

indicating 3V wall en-face B. High-magnification of 3V with square selection(C) focusing on the posterior basal 

3V wall. C. High-magnification of posterior basal 3V with tanycyte region (red) and ependymal region indicated. 

Needle denotes placement from which fluorescent beads will be deposited in flow videos. 
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Figure 2. Measuring Translational Polarity of Individual Ependymal Cell A. 63x magnification of 

Beta-Catenin(green) which labels individual ependymal cell membrane while gamma-tubulin(red) 

labels individual basal bodies. B. Segmentation of beta-catenin channel (white) merged with 

individual basal bodies(red).  C. Vector measure of translational polarity exhibited by a single 

ependymal cell. D. Polar histogram for each individual cell constituting one 63x tile image. Polarity 

points left with most cells pointing towards 260 degrees from 0. 
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Figure 3: Left Hemisphere Flow. Image stack of individual stills captured from a left hemisphere flow 

video (Movie 1). White lines outline the left posterior basal 3V wall. Flow within the left hemisphere 

after bead deposition is directed anterior and ventral as indicated by red arrows. Flow does not cross 

the tanycyte region(red).  
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Figure 4: Translational Polarity of Left Hemisphere. Histological preparation of a LH flow with 

Beta-Catenin(green) and Gamma-Tubulin(red) merged. 4x4 grid indicates region sampled for 

translational polarity analysis. Subsequent 4x4 grid with individual polar histograms corresponds 

accordingly. Red arrows in individual polar histograms points in the average direction of each 

individual translational polarity contained within each individual gride/tile sampled. Overall, LH 

translational polarity points posterior and ventral towards the tanycytic domain. 
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Figure 5: Right Hemisphere Flow. Image stack of individual stills captured from a RH flow video 

(Movie 2). White lines outline the right posterior basal 3V wall. Flow within the RH after bead 

deposition is directed posterior and ventral as indicated by red arrows. As beads enter the tanycyte 

region(red) flow is then directed dorsal. 
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Figure 6: Translational Polarity of Right Hemisphere. Histological preparation of a RH flow with Beta-

Catenin(green) and Gamma-Tubulin(red) merged. 4x4 grid indicates region sampled for translational 

polarity analysis. Subsequent 4x4 grid with individual polar histograms corresponds to histological grid. 

Red arrows in individual polar histograms points in the average direction of each individual ependymal 

translational polarity contained within each grid/tile sampled. Overall, RH translational polarity points 

posterior and ventral towards the tanycytic domain. 
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